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Cataloging Reports

This update chapter describes 
changes to the Report of 
Technical Services Activities 
(RTSA) for Cataloging and 
Acquisitions accounts.

Insert these pages behind the 
Cataloging Reports tab of the 
Reports Manual.

Changes to Report of Technical Services
   Activities (RTSA) 3





Changes to Report of Technical Services Activities (RTSA)
Changes to Report of Technical Services 
Activities (RTSA)

Some changes have been made to the Report of Technical Services 
Activities (RTSA) for Cataloging statistics. Here are the changes:

• When you use Archive Bibliographic Records (ABR) to force 
indexing of a non-owned bib, you can now see the counts for 
this action in New Bibs Added and Authorities New sections.

• Group Update Holdings (GUH) now counts the total number of 
holdings modified and not the number of times you use GUH.

• When you use Batch Change (BC) in the Holdings Summary 
screen, you can now see the counts for Holdings Modified.

• The count heading “Holdings Repl(BC)” is now called 
“Barcodes Replaced.”

One change was also made to the Report of Technical Services Activities 
(RTSA) for the Acquisitions account:

• The heading “Invoices Created” has been changed to “Items 
Invoiced.” This counts the number of items invoiced.
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Circulation Reports

This update chapter describes a 
new feature that lets you specify 
which days of the week you 
want certain types of notices 
printed.

This update chapter also 
describes a documentation 
change for the descriptions of 
Patron Statistical Classes and 
Patron Loan Types for the Daily 
and Monthly Statistical Report.

Insert these pages behind the 
Circulation Reports tab of the 
Reports Manual.

Notice Production Scheduling by Notice Type 3

Daily and Monthly Statistical Reports 4





Notice Production Scheduling by Notice Type
Notice Production Scheduling by Notice Type
If you want to control when you print and send certain types of notices 
(for example, because your library may have a limited postal budget), 
you can use the new Update Notice Production Schedule (UNPS) 
feature. This feature lets you specify which types of notices you want 
printed on which days of the week.

To specify which notices are printed on which days

1 Enter “UNPS” (Update Notice Production Schedule) at any 
Circulation menu.

 The system displays the Notice Production control record:

2 Use FM commands to complete or update the record.

At each field, you can enter “.?” for field help. (See Reference 
Tools for a printed copy of field help.)

3 Enter “F” to file the record.

The system displays a prompt asking if you want to copy the 
changes to other accounts.

4 If you want to copy the changes for this record to other 
Circulation accounts, enter “Y” (Yes).

5 Enter “Q” to quit.

                               CRECS Maintenance                   
 Enter CRECS KEY : DEP.AG.NOTICES.DATE  *** NEW ADDITION ***  
 
 
 

  
        
   
      
   
       
  
      
  
       
   
    
  
       
   
 
 
 

 1  1st O’due Notice
 2  2nd O’due Notice
 3  3rd O’due Notice
 4  4th O’due Notice
 5  Final O’due Not.
 6  Recall Notice
 7  Hold Notice
 8  Billing Notice
 9  Hold Cancld. Not.
 10 Hold Expired Not.
 11 Sub. Renewal Not.
 ### END OF RECORD ###
 
 
 
 
 
 
 
 1  1st O’due Notice                                <
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Dynix 180 Update: Circulation Reports
Daily and Monthly Statistical Reports
The Use Count for Patron Statistical Classes (PSTAT) and Patron Loan 
Types (PTYPE) is not the number of patrons who actually used the 
system during a specific time period. The Use Count shows the number 
of items checked out to each PSTAT or PTYPE. The count is the number 
of checkouts.
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System Reports

This update chapter describes a 
new feature that lets you create 
your own Recall reports 
(UMISCR) and run them from 
the Reports menu (MISCR).

Insert these pages behind the 
System Reports tab of the 
Reports Manual.

Miscellaneous Reports Overview 3

Using the Interface 3

Creating a Miscellaneous Report 18

Printing a Miscellaneous Report 19





Miscellaneous Reports Overview
Miscellaneous Reports Overview
Several reports are installed on your Dynix system. If you want, you can 
create additional routine reports that your library runs by using Recall 
commands. (Recall is taught in an Ameritech Library Services 
workshop.) For example, you can create unique statistical reports on 
different collections. Then, you or anyone who has the correct security 
level, can print the report at any time.

You create reports from the System Administrator Menu with Update 
Miscellaneous Reports (UMISCR). You can attach a security level to the 
report so that only someone with the right security level can print a 
report from the Reports menu (MISCR).

The interface for creating and printing your reports is the same as the 
Acquisitions interface. If you do not have Acquisitions or have not used 
Acquisitions, you may want to read “Using the Interface.”

This section explains how to:

• Use the interface.

• Create a miscellaneous report.

• Run a miscellaneous report.

Using the Interface
The options for creating and printing your miscellaneous reports have a 
different “look and feel” than the regular Dynix FM screens (the same as 
Acquisitions). This new interface simplifies workflow by letting you 
access many options from a single screen. It features pull-down menus, 
full-text editing, pop-up windows, and special command keys to help 
you do your tasks quickly and easily. It also provides online help to 
guide you every step of the way. This section explains the interface and 
how you can use it to do your tasks more effectively.
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Dynix 180 Update: System Reports
Command Keys
You use command keys to move between fields and screens, access drop 
boxes and pull-down menus, edit fields, and do other tasks. The keys 
you press for these functions vary between emulations. This guide 
assumes you know the correct keys for your emulation and how to use 
them.

When you are instructed to press a command (for example, “Press 
<Save>”), look at the command line to see if the command is displayed. 
Here is a sample command line:

If the command you want is not displayed, you must refer to the list of 
commands for your emulation.

Command 
line

The name of 
the command

The keystroke 
for the command
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Using the Interface
To print the list of commands

1 Enter “MISCR” (Miscellaneous Reports) at any system menu.

2 Press the Help command key (usually F3) two or three times 
until the system help window appears. (If F3 does not work, ask 
your system administrator for the correct key.)

3 Move the cursor to <Functions> and press RETURN to display 
the list of commands:

To page down the list, move the cursor to <Next Page> and 
press RETURN. To page up the list, move the cursor to 
<Previous Page> and press RETURN.

4 Make a screen print of each page of the list for future reference. 
To do this, press <Print Screen> (ESC,P on most emulations). If 
you want, use the printout to complete the last column in the 
charts that follow.

5 Press <Quit> two or three times to exit help.

The name of each command. This guide 
uses these names in tasks (for example, 
“Press <Search>”).

The keys you press for each command. For 
example, with this emulation you would press F2 
to do a search.
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Dynix 180 Update: System Reports
This chart lists the commands you will use most frequently:

Command 
name

Purpose
Key on most 
emulations

Key on your 
emulation

Save To save your changes to a record, screen 
or editing window.

F1

Search To access a search menu from certain 
fields (see “Searching” on page 30 of the 
Acquisitions User’s Guide), or to display a 
list of valid options for a field (see 
“Accessing a Drop Box” on update page 
16).

F2

Help To display online help for a field (see 
“Accessing Online Help” on update 
page 17).

F3

Menu To access a pull-down menu (see “Pull-
down Menus” on update page 8).

F4

Quit To quit a field or screen without saving 
your changes (if any).
• If you accidentally type something into 

a field, press <Quit> to cancel your 
typing and to redisplay the original text 
(if any).

• If you want to erase your changes to 
several fields on a screen, press <Quit>, 
then choose <Yes> when you are 
prompted: “Your changes will be lost! 
Do you still want to exit?”

• Press <Quit> to quit Help or any other 
screen.

ESC

Exit To quit a process completely. In many 
cases, this command takes you back to an 
Acquisitions menu.

ESC,X

Delete To delete a field. To do this, move the 
cursor to the field you want to delete, and 
press <Delete>.

DEL
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Using the Interface
Next 
Prompt

To move from field to field in a logical 
sequence.

RETURN or 
TAB

Prev. 
Prompt

To move back one field. SHIFT+TAB

Up To move the cursor up. Up arrow

Down To move the cursor down. Down 
arrow

Right To move the cursor to the right. Right arrow

Left To move the cursor to the left. Left arrow

Insert Depending on where you are:
• To select all items in certain lists, such 

as an order work list (see update 
page 15).

• To insert a new line in a multi-value 
field.

• To change the editing mode from 
“Insert” to “Typeover.”

ESC,I

Edit To activate full-text editing for a field (see 
update page 11).

CNTRL+E

Goto Depending on where you are:
• To go to a certain field (press <Goto> 

and the name of the field or the 
information in the field).

• To go to a certain line number in a list 
(press <Goto> and the number of the 
line).

• To go to a certain item in a drop box 
(press <Goto> and the number or the 
beginning letters of the item).

ESC,G

Command 
name

Purpose
Key on most 
emulations

Key on your 
emulation
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Dynix 180 Update: System Reports
Note the following about key commands: 

• Pressing command keys. If key commands are separated by 
a comma (for example, “ESC,I”), you must press the keys 
quickly, one after the other. If key commands are separated 
by a plus (for example, “CNTRL+E”), you must press the 
keys at the same time.

• Escape-key sequences. If your function keys (keys that start 
with the “F”) are programmed for other functions, you can 
use the an escape-key sequence for commands assigned to 
these keys instead. For example, if the Search command is 
F2 for your emulation, but your F2 key is programmed for 
another function, you can press ESC,2 to do a search. You 
can press ESC,1 for F1, ESC,3 for F3, and so on. You can use 
the escape sequence for function keys F1–F9.

Pull-down Menus
You can access options from pull-down menus. For example, you may 
be able to delete a report by choosing “Delete” from the File menu. In the 
documentation, the steps tell you: “Choose File, Delete.”

To access a menu option

1 Press <Menu> (F4 on most emulations) to access the pull-down 
menus.

2 Move the cursor to the menu option you want (File, Option, or 
Help), or type the first letter of the option (for example, press 
“H” to move to the Help menu option).
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Using the Interface
3 Press <Down> to display the pull-down menu. Here is a sample 
menu:

4 Move the cursor to the option you want (or type the first letter of 
the option you want) and press RETURN.

Hot Keys
Several options on pull-down menus can be accessed immediately by 
pressing a hot key. If a hot key is available for an option, it appears next 
to the option in the pull-down menu.

Hot keys
Reports Manual 9



Dynix 180 Update: System Reports
Moving Around Screens
This chart shows how to move around screens:

To do this
Use this 

command
Key on most 
emulations

Key on your 
emulation

Move to the top of a 
record

<Top> HOME,
Up arrow

Move to the bottom of a 
record

<Bottom> HOME,
Down arrow

Move to the top of the 
previous screen in a 
multiscreen display

<Prev. Set> Page,
Up arrow

Move to the top of the 
next screen in a 
multiscreen display

<Next Set> Page,
Down arrow

Move directly to a certain 
place on a screen

<Goto> ESC,G
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Using the Interface
Moving Between Fields
To complete or update fields, you must first move the cursor to the field 
you want. This chart shows how to move between fields:

Editing a Field
If you want, you can change a word or a phrase in a field without 
reentering the entire field.

1 Move the cursor to the field you want to edit.

2 Press <Edit> (CTRL+E on most emulations).

To do this Use this command
Key on most 
emulations

Key on your 
emulation

Move from 
field to field in 
a logical 
sequence

<Accept Entry> or 
<Next Prompt> 
If you press <Accept 
Entry> at a required 
field, the system tells 
you the field is 
required. To move past 
the field without 
completing it, press 
<Next Prompt> or an 
arrow key.

RETURN or 
TAB

Move to a 
particular 
field

<Up>, <Down>, 
<Left>, <Right> 

Arrow keys

Move back 
one field

<Prev. Prompt> SHIFT+TAB

Move directly 
to a certain 
field

<Goto> ESC,G
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Dynix 180 Update: System Reports
3 If you want to display a full editing screen for the field, press 
<Edit> again:

4 Edit the field using the command keys in this chart. Then press 
<Save>.

The current editing mode. “Insert” lets you insert new information 
without replacing the old. “Typeover” lets you type new information 
over the old. To change editing modes, press <Insert>.

To do this
Use this 

command
Key on most 
emulations

Key on your 
emulation

Move to the left <Left> Left arrow

Move to the right <Right> Right arrow

Move forward one word <Next 
Prompt>

TAB

Move back one word <Prev. 
Prompt>

SHIFT+TAB

Move to the beginning of a line <Beginning 
of Line>

HOME,
Left arrow

Move to the end of a line <End of 
Line>

HOME,
Right arrow
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Using the Interface
To do this
Use this 

command
Key on most 
emulations

Key on your 
emulation

Move to the next line <Down> Down arrow

Move to the previous line <Up> Up arrow

Move to the top of the text <Top> HOME,
Up arrow

Move to the bottom of the text <Bottom> HOME,
Down arrow

Move to a certain word or 
character

<Goto> ESC,G

Delete information character by 
character from right to left

<Backspace> BACKSPACE

Delete information character by 
character from left to right

<Delete 
Character>

DEL

Delete a word <Delete 
Word>

CNTRL+W

Change the editing mode from 
“Insert” to “Typeover” or vice 
versa

<Insert> INS

Save your changes and exit the 
field

<Save> F1

Exit the field without saving your 
changes

<Quit> ESC
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Dynix 180 Update: System Reports
Moving Around in a List
This chart lists the options for moving around in a list. These options 
apply to lists that appear when you press <Search> in a coded field, as 
well as other lists, such as an order work list. Some options are especially 
helpful if the list is long.

To go
Use this 

command
Key on most 
emulations

Key on your 
emulation

Down one line <Down> Down arrow

Up one line <Up> Up arrow

Down one screen <Next Set> Page,
Down arrow

Up one screen <Prev. Set> Page, Up 
arrow

To the top of the list <Top> HOME,
Up arrow

To the bottom of a list <Bottom> HOME,
Down arrow

Directly to an item The first letter 
of the item
or
<Goto>

The first letter 
of the item

ESC,G

The first letter 
of the item 
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Using the Interface
Selecting Items in a List
At certain lists, you can select one or more items to update. Selecting 
multiple items lets you update them one after the other. For example, in 
Acquisitions you can select multiple orders in an order work list to 
update them one after the other.

To select or deselect an item, go to the item and press the space bar. A 
“1” appears next to the first item you select, a “2” next to the second 
item, and so on. This chart explains the options for selecting and 
deselecting items in a list:

To Do this

Select all items Press <Insert>. 

Select a range of items Go to the first item and press “<”. 
Then go to the last item and press “>”. 
The system selects everything in from 
“<” to “>”. 

Select items 
individually

Go to the first item and press the 
space bar; then repeat this for each 
additional item you want to select. 

To deselect all selected 
items

Press <Delete>. 

To deselect a range of 
items

Go to the last item in the selected 
range and press “>”. 

To deselect items 
individually

Go to the selected item and press the 
space bar; repeat this for each 
additional item you want to deselect.
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Dynix 180 Update: System Reports
Choosing an Option at a Pop-up Window
This guide may instruct you to “choose” an option at a pop-up window 
like the one below. You choose an option by moving the cursor to the 
option you want and pressing RETURN. You can move the cursor by 
pressing <Right> or <Left>, or by pressing the first letter of the option 
you want. For example, you can press “O” at the window below to move 
the cursor to the <OK> option.

Accessing a Drop Box
If you are completing a coded field, you can press <Search> (F2 on most 
emulations) in the field to display a list of codes to choose from. The list 
is called a “drop box.” Here is a sample drop box for the CURRENCY 
field on the order record:

You choose a code by highlighting it and pressing RETURN. To move 
around in the list, see update page 14.

The description 
of each code

The valid codes 
for this field

Shows where you are in the list. In this 
example, the cursor is at the first of 44 codes.
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Using the Interface
Accessing Online Help
You can access online help for fields and menu bar options, as explained 
below:

1 Move the cursor to the field or menu bar option you want help 
for.

2 Press <Help> (F3 on most emulations) to display a short help 
message at the bottom of the screen:

This symbol means additional help 
is available for the field or option.
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Dynix 180 Update: System Reports
3 Press <Help> again to display additional help, if available:

4 If you want, press <Print Screen> (ESC,P on most emulations) to 
print the screen so you can refer to the help after exiting the 
screen.

5 Press <Quit> to leave help.

Creating a Miscellaneous Report

To create a report

1 Access the account for which you want to create a report.

2 Enter “UMISCR” (Update Miscellaneous Reports).
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Printing a Miscellaneous Report
The system displays the Update Miscellaneous Reports window:

3 Enter the code you want for the report.

4 Enter the security level you want for this report.

The security level lets those with the level you enter or above 
print the report in Miscellaneous Reports (MISCR).

5 Enter a description of the report.

6 Enter the Recall statement that will run to print the report.

7 Press <Save> to exit the Recall Statement part of the window.

8 Press <Save> again to save the report.

9 Repeat steps 3–8 for each new report you want; otherwise, press 
<Quit>.

Printing a Miscellaneous Report

To print a report

1 Access the account for which you want to print a miscellaneous 
report.

2 Enter “MISCR” (Miscellaneous Report).
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Dynix 180 Update: System Reports
The system displays the Miscellaneous Reports window: 

3 Choose where you want the report to print. (For more 
information on how to choose where to print the report, see 
“Moving Between Fields” on update page 11 and “Accessing a 
Drop Box” on update page 16.)

4 Choose the report you want. (For more information on choosing 
the report, see “Moving Between Fields” on update page 11 and 
“Moving Around in a List” on update page 14.)

5 Press <Generate report> when you are ready to print the report.

Here is an example of a report:

6 Press <Quit>.
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